
CCA-101: Fundamentals of IT & Programming 

Assignment -1 

 

Q1: What are the four fundamental parts of computer? Explain it with the help of diagram. 

Ans.  Computer Block Diagram System: Mainly computer system consists of three 
parts, that are central processing unit (CPU), Input Devices, and Output Devices. 
The Central Processing Unit (CPU) is divided into two parts again: arithmetic 
logic unit (ALU) and the control unit (CU). The set of instruction is in the form of 
raw data. 

A large amount of data is stored in the computer memory with the help of primary and 
secondary storage devices. The CPU is like the heart/brain of the computer. The 
user does not get the desired output, without the necessary option taken by the 
CPU.  The Central processing unit (CPU) is responsible for the processing of all 
the instructions which are given by the user to the computer system. 

 

                                       Fig: Block Diagram of the computer. 
The data is entered through input devices such as the keyboard, mouse, etc. This set of 

instruction is processed by the CPU after getting the input by the user, and then 
the computer system produces the output. The computer can show the output 
with the help of output devices to the user, such as  monitor, printer, etc. 

 CPU (Central Processing Unit) 

 Storage Unit 

 ALU(Arithmetic Logic Unit) 

https://www.tutorialandexample.com/input-devices-of-computer/
https://www.tutorialandexample.com/output-devices-of-computer/


 Control Unit 

Central Processing Unit (CPU) 
The computer system is nothing without the Central processing Unit so, it is also known 

as the brain or heat of computer. The CPU is an electronic hardware device 
which can perform different types of operations such as arithmetic and logical 
operation. 

 

The CPU contains two parts: the arithmetic logic unit and control unit. We have 
discussed briefly the arithmetic unit, logical unit, and control unit which are given 
below: 

Control Unit 
The control unit (CU) controls all the activities or operations which are performed inside 

the computer system. It receives instructions or information directly from the main 
memory of the computer. 

When the control unit receives an instruction set or information, it converts the 
instruction set to control signals then; these signals are sent to the central 
processor for further processing. The control unit understands which operation to 
execute, accurately, and in which order. 

Arithmetic and Logical Unit 
The arithmetic and logical unit is the combinational digital electronic circuit that can 

perform arithmetic operations on integer binary numbers.It presents the arithmetic 
and logical operation. The outputs of ALU will change asynchronously in 
response to the input. The basic arithmetic and bitwise logic functions are 
supported by ALU. 

Storage Unit 
The information or set of guidelines are stored in the storage unit of the computer 

system. The storage unit provides the space to store the data or instruction of 
processed data. The information or data is saved or hold in computer memory or 
storage device. The data storage is the core function and fundamental of the 
computer components.   

https://en.wikipedia.org/wiki/Central_processing_unit


Components of Computer System 
The hardware and software exist on the computer.  The information which is stored 

through the device is known as computer software. The hardware components of 
the computer system are related to electronic and mechanical parts, and the 
software component is related to data and computer programs. Many elements 
are connected to the main circuit board of the computer system called a 
“motherboard.” 

 

 Processor. 

 Main Memory. 

 Secondary Memory. 

 Input Devices. 

 Output Devices. 
These are mainly five components of the computer system. The computer hardware, 

computer software, and liveware exist in the element of the computer system. 

Processor 
The processor is an electric circuitry within the computer system. The Central processing 

unit is the central processor or main processor of the computer system. The 
processor carries out the instructions of the computer program with the help of 
basic arithmetic and logic, input/output operations. 

Main Memory   
The Random Access Memory is the main memory of the computer system, which is 

known as RAM.  The main memory can store the operating system software, 
application software, and other information.  The Ram is one of the fastest 
memory, and it allows the data to be readable and writeable. 

Secondary memory 
 We can store the data and programs on a long-term basis in the secondary memory. 

The hard disks and the optical disks are the common secondary devices. It is 



slow and cheap memory as compare to primary memory. This memory is not 
connected to the processor directly. 

It has a large capacity to store the data. The hard disk has a capacity of 500 gigabytes. 
The data and programs on the hard disk are organized into files, and the file is 
the collection of data on the disk. The secondary storage is direct access by the 
CPU; that‟s why it is different from the primary storage. 

The hard disk is about 100 times the capacity of the main memory. The main difference 
between primary and secondary storage is speed and capacity. There are several 
large blocks of data which are copied from the hard disk into the main memory. 

Input Devices 
The user provides the set of instruction or information to the computer system with the 

help of input devices such as the keyboard, mouse, scanner, etc. The data 
representation to the computer system is in the form of binary language after that 
the processor processes the converted data. The input unit implements the data 
which is instructed by the user to the system. 

We can enter the data from the outside world into the primary storage as the input 
through input devices. The input devices are the medium of communication 
between the outside world and the computer system. 

There are some important features of input devices which are given below: 

1. The input devices receive or accept the data or instruction from the user, who 

exist in the outside world. 

2. These devices convert the data or instruction into the machine-readable form for 

further processing. 

3. The input device performs like the connection between the outside world and our 

computer system. 

4. The keyboard and mouse are common examples of input devices. 

5. When the whole procedure is finished, we get the desired output from the output 

devices such as monitor, printer, etc. 

Output Devices 
The output devices produce or generate the desired result according to our input, such 

as a printer, monitor, etc. These devices convert the data into a human-readable 
form from binary code. 

The computer system is linked or connected to the outside world with the help of output 
devices. The primary examples of output devices are a printer, projector, etc. 

These devices have various features which are given below: 

1. These devices receive or accept the data in the binary form. 

2. The output devices convert the binary code into the human-readable form. 

3. These devices produce the converted result and show to the user. 
 

Q2: Discuss about the classification of computers based on size and capacity. 

Ans. Computer's Classification 

https://en.wikipedia.org/wiki/Binary_code


Computers are classified on different parameters, such as, storage capacity, processing speed 

and component (CPU) used in computers. Depending upon the components used and 

features of different computers, they are classified into four groups, Microcomputers, 

Minicomputers, Mainframe computers and Supercomputers. 

  

Micro Computers 

Micro Computer is a computer whose CPU (Central Processing Unit) is a microprocessor. All the 

components of a microprocessor are on a single integrated circuit chip. Micro computer can 

be categorized as the desktop, programmable and workstation. The microprocessor based 

computers are called third generation computers. They are the backbone of the modern 

computer era. The first and second generation computers are based on vacuum tubes and 

bipolar junction transistors. 

  

 

  

Desktop Computers 

Desktop computer is a type of microcomputer. A desktop computer has a keyboard for input 

data, a LCD or CRT monitor to display information and Central processing unit tower 

contains storage, memory, different types of drives, such as, CD drive, hard drive, etc. A 

desktop computer is mainly used at home and office applications. 

  

Programmable Computers (PDA) 

Personal digital assistance is a type of hand held programmable digital computer. It is used as 

notepads, address books and can connect to world web wave to share information. A PDA 

is equipped with mobile phone hence, called smallest computer. 

  



  

Workstation 

A workstation computer has greater memory capability and more extensive mathematical 

abilities. It is connected with other workstation computers or personal computer to exchange 

data and mostly used for scientific applications. It also supports multitasking applications. 

  

Mini Computers 

Minicomputers were introduced in early 1960s. They were faster than micro computers. Basically 

these computers were mainly multi-user systems, where many users work on the systems. 

Generally these types of computers had larger memories and greater storage capacity. They 

had large instruction set and address field. These kinds of computers have efficient storage 

for handling of text, in comparison to lower bit machines. Due to more efficient processor, 

speed and memory size, minicomputer was used in variety of applications and could support 

business applications along with the scientific applications. Minicomputer was a multi-user 

system which means more than one user could use this system simultaneously. 

  

Comparison of Micro and Mini computers 

  

Features Microcomputer Minicomputer 

Primary 
memory  

Shall memory Larger memory 

Word length  Small word 
length  

Larger word length 

Cost low Low High 

Processor Low High 

  

Mainframe Computers 

Mainframe computers are large and expensive machines. The word length of mainframe 

computers may be 48, 60 or 64 bits, memory capacity being in some megabytes and 

storage capacity in some terabytes. Generally they handle huge volumes of information and 

data. In terms of speed, they are having significant processing capacity. They are used in 

research organizations, large industries, airlines reservation where a large database has to 

be maintained. 

  



 

  

Super Computers 

Super Computers are the fastest computer in current era. The processing capabilities of super 

computer lies in the range of GIPS2, word length 64-128 or may be in 256 or so. The 

memory capacity of super computer is in some gigabytes or in terabytes. The storage 

capacity of this type of computer is in exabytes. 

  

 

  

The parallel processing of a super computer makes it very fast because it contains number of 

CPU that operates parallel. They are used at some research centers and government 

agencies involving sophisticated scientific and engineering tasks. 



  

Super computers are used for the followings: 

  

  Weapons research and development 

  Nuclear and plasma physics 

  Rocket research and development 

  Atomic research 

  Aerodynamics 

  

Units For Measuring Word Length, Data, And Storage Capacity of a Computer 

Computers are classified on the basis of their data processing speed better known as clock 

speed and the word length. The word length that is processed by a CUP at a time is one of 

the important feature of that CPU. 

  

The followings are the units for the measurement of data volume: 

  

bit bit 0 or 1 

Byte B 8 bite 

Kibibit Kibit 1024 bits 

kilobit Kbit 1000 bits 

kibibyte (binary) KiB 1024 bytes 

kilobyte (decimal) kB 1000 bytes 

megabit Mbit 1000 kilobits 

mebibyte (binary) MiB 1024 kibibytes 

megabyte 

(decimal) 

MB 1000 kilobytes 

gigabit Gbit 1000 megabits 

gibibyte (binary) Gibbs 1024 mebibytes 

gigabyte (decimal) GB 1000 megabytes 

terabit Tbit 1000 gigabits 

tebibyte (binary) TIB 1024 gibibytes 

terabyte (decimal) TB 1000 gigabyte 

Petabit Pbit 1000 terabyte  

pebibyte (binary) PiB 1024 tebibytes 

petabyte (decimal) PB 1000 terabytes 

exabit Ebit 1000 petabits 

exbibyte (binary) EiB 1024 pebibytes 

exabyte (decimal 
  



 

Q3: What is the meaning of computer generation? How many Computer Generations are 

defined? What technologies were/are used? 

Ans. Generation in computer terminology is a change in technology a computer 
is/was being used. Initially, the generation term was used to distinguish between 
varying hardware technologies. Nowadays, generation includes both hardware and 
software, which together make up an entire computer system. 

There are five computer generations known till date. Each generation has been 
discussed in detail along with their time period and characteristics. In the following 
table, approximate dates against each generation has been mentioned, which are 
normally accepted. 

Following are the main five generations of computers. 

S.No Generation & Description 

1 
First Generation 

The period of first generation: 1946-1959. Vacuum tube based. 

2 
Second Generation 

The period of second generation: 1959-1965. Transistor based. 

3 
Third Generation 

The period of third generation: 1965-1971. Integrated Circuit based. 

4 

Fourth Generation 

The period of fourth generation: 1971-1980. VLSI microprocessor 
based. 

5 

Fifth Generation 

The period of fifth generation: 1980-onwards. ULSI microprocessor 
based. 

         What is a computer? Computer is an advanced electronic device that takes raw data as an input 

from the user and processes it under the control of a set of instructions (called program), 

produces a result (output), and saves it for future use. This tutorial explains the foundational 

concepts of computer hardware, software, operating systems, peripherals, etc. along with how 

to get the most value and impact from computer technology. Functionalities of a Computer 

There are three basic functionalities of a Computer System and they are 1. Input 2. Process 3. 

Output But if we look at it in a very broad sense, any digital computer carries out the following 

five functions: Step 1 - Takes data as input. Step 2 - Stores the data/instructions in its memory 

https://www.tutorialspoint.com/computer_fundamentals/computer_first_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_second_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_third_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_fourth_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_fifth_generation.htm


and uses them as required. Step 3 - Processes the data and converts it into useful information. 

Step 4 - Generates the output. Step 5 - Controls all the above four steps. Computer Input 

Process Output 2 Advantages of Computers Following are certain advantages of computers. 

High Speed • Computer is a very fast device. • It is capable of performing calculation of very 

large amount of data. • The computer has units of speed in microsecond, nanosecond, and even 

the picosecond. • It can perform millions of calculations in a few seconds as compared to man 

who will spend many months to perform the same task. Accuracy • In addition to being very 

fast, computers are very accurate. • The calculations are 100% error free. • Computers perform 

all jobs with 100% accuracy provided that the input is correct. Storage Capability • Memory is a 

very important characteristic of computers. • A computer has much more storage capacity than 

human beings. • It can store large amount of data. • It can store any type of data such as 

images, videos, text, audio, etc. Diligence • Unlike human beings, a computer is free from 

monotony, tiredness, and lack of concentration. • It can work continuously without any error 

and boredom. • It can perform repeated tasks with the same speed and accuracy. Versatility • A 

computer is a very versatile machine. • A computer is very flexible in performing the jobs to be 

done. • This machine can be used to solve the problems related to various fields. • At one 

instance, it may be solving a complex scientific problem and the very next moment it may be 

playing a card game. 3 Reliability • A computer is a reliable machine. • Modern electronic 

components have long lives. • Computers are designed to make maintenance easy. Automation 

• Computer is an automatic machine. • Automation is the ability to perform a given task 

automatically. Once the computer receives a program i.e., the program is stored in the 

computer memory, then the program and instruction can control the program execution 

without human interaction. Reduction in Paper Work and Cost • The use of computers for data 

processing in an organization leads to reduction in paper work and results in speeding up the 

process. • As data in electronic files can be retrieved as and when required, the problem of 

maintenance of large number of paper files gets reduced. • Though the initial investment for 

installing a computer is high, it substantially reduces the cost of each of its transaction. 

Disadvantages of Computers Following are certain disadvantages of computers. No I.Q. • A 

computer is a machine that has no intelligence to perform any task. • Each instruction has to be 

given to the computer. • A computer cannot take any decision on its own. Dependency • It 

functions as per the user’s instruction, thus it is fully dependent on humans. Environment • The 

operating environment of the computer should be dust free and suitable. No Feeling • 

Computers have no feelings or emotions. • It cannot make judgment based on feeling, taste, 

experience, and knowledge unlike humans. 4 Application of Computers in Various Fields 

Business A computer has high speed of calculation, diligence, accuracy, reliability, or versatility 

which has made it an integrated part in all business organizations. Computer is used in business 

organizations for: • Payroll Calculations • Budgeting • Sales Analysis • Managing Employee 

Database • Maintenance of stocks, etc. Banking Today, banking is almost totally dependent on 

computers. Banks provide the following facilities: • Online accounting facility, which includes 

checking current balance, making deposits and overdrafts, checking interest charges, shares, 

and trustee records. • ATM machines which are completely automated are making it even 

easier for customers to deal with banks. Insurance Insurance companies are keeping all records 

up-to-date with the help of computers. Insurance companies, stock broking firms are widely 

using computers for their concerns. Insurance companies are maintaining a database of all 

clients with information showing: • Procedure to continue with policies • Starting date of the 



policies • Next due installment of a policy • Maturity date • Interests due • Survival benefits • 

Bonus Education The computer helps in providing a lot of facilities in the education system. • 

The computer provides a tool in the education system known as CBE (Computer Based 

Education). • CBE involves control, delivery, and evaluation of learning. • Computer education is 

rapidly increasing the graph of number of computer students. • There are a number of methods 

in which educational institutions can use a computer to educate the students. • It is used to 

prepare a database about performance of a student and analysis is carried out on this basis. 5 

Marketing In marketing, uses of the computer are following: • Advertising - With computers, 

advertising professionals create art and graphics, write and revise copy, and print and 

disseminate ads with the goal of selling more products. • Home Shopping - Home shopping has 

been made possible through the use of computerized catalogues that provide access to product 

information and permit direct entry of orders to be filled by the customers. Healthcare 

Computers have become an important part in hospitals, labs, and dispensaries. They are being 

used in hospitals to keep the record of patients and medicines. It is also used in scanning and 

diagnosing different diseases. ECG, EEG, ultrasounds and CT scans, etc. are also done by 

computerized machines. Following are some major fields of health care in which computers are 

used. • Diagnostic System - Computers are used to collect data and identify the cause of illness. 

• Lab-diagnostic System - All tests can be done and the reports are prepared by computer. • 

Patient Monitoring System - These are used to check the patient's signs for abnormality such as 

in Cardiac Arrest, ECG, etc. • Pharma Information System - Computer is used to check drug 

labels, expiry dates, harmful side effects, etc. • Surgery - Nowadays, computers are also used in 

performing surgery. Engineering Design Computers are widely used for Engineering purpose. 

One of the major areas is CAD (Computer Aided Design) that provides creation and modification 

of images. Some of the fields are: • Structural Engineering - Requires stress and strain analysis 

for design of ships, buildings, budgets, airplanes, etc. • Industrial Engineering - Computers deal 

with design, implementation, and improvement of integrated systems of people, materials, and 

equipment. • Architectural Engineering - Computers help in planning towns, designing 

buildings, determining a range of buildings on a site using both 2D and 3D drawings. Military 

Computers are largely used in defence. Modern tanks, missiles, weapons, etc. Military also 

employs computerized control systems. Some military areas where a computer has been used 

are: • Missile Control • Military Communication • Military Operation and Planning • Smart 

Weapons 6 Communication Communication is a way to convey a message, an idea, a picture, or 

speech that is received and understood clearly and correctly by the person for whom it is 

meant. Some main areas in this category are: • E-mail • Chatting • Usenet • FTP • Telnet • 

Video-conferencing Government Computers play an important role in government services. 

Some major fields in this category are: • Budgets • Sales tax department • Income tax 

department • Computation of male/female ratio • Computerization of voters’ lists • 

Computerization of PAN card • Weather forecasting 7 Generations of Computers Generation in 

computer terminology is a change in technology a computer is/was being used. Initially, the 

generation term was used to distinguish between varying hardware technologies. Nowadays, 

generation includes both hardware and software, which together make up an entire computer 

system. There are five computer generations known till date. Each generation has been 

discussed in detail along with their time period and characteristics. In the following table, 

approximate dates against each generation has been mentioned, which are normally accepted. 

Following are the main five generations of computers. Sl. No. Generation & Description 1 First 



Generation The period of first generation: 1946-1959. Vacuum tube based. 2 Second 

Generation The period of second generation: 1959-1965. Transistor based. 3 Third Generation 

The period of third generation: 1965-1971. Integrated Circuit based. 4 Fourth Generation The 

period of fourth generation: 1971-1980. VLSI microprocessor based. 5 Fifth Generation The 

period of fifth generation: 1980-onwards. ULSI microprocessor based 

Technology has evolved and shaped our workplaces in many ways, through 
the adoption of tools like the internet and email for communications, word 
processing, spreadsheets and presentations for office productivity, electronic 
databases for record keeping, and robots and artificial intelligence for 
automation. 
Technology is indispensable in our work-lives, and it pervades every aspect of 
businesses and the public space. 
Here are 10 ways in which technology has become an integral part of 
everyday work: 

1. Communications technologies 

 

Technology is used widely in almost every industry -- you must know how to use it in 

your chosen field! 

Long distance communication is one area where technology has made a profound 

impact on workplaces. Businesses used to employ fax machines, surface mail and the 

telephone in the past. 

Today, email, SMS, and various chat software tools have become the principal modes 

of business communication. Also, the use of video conferencing is on the rise, thus 

reducing the need for physical travel. 

2. Office productivity 



 

Word processing, spreadsheets, digital presentations and other office productivity 

software have become so commonplace that their use has become routine, and this has 

completely transformed office work. 

Office software is now becoming integrated with other productivity and decision 

making tools like PowerBI and this new wave will revolutionise the workplace again. 

3. Record keeping and retrieval 

 

Another area where advanced technology is already ubiquitous is record keeping. 

Most businesses have switched to electronic databases, rather than paper files, to store 

and access their records, and this has become an essential and everyday part of our 

work environment. 

 
Q4: Differentiate between Volatile & Non- Volatile memories. 



Ans. Volatile and Non-Volatile Memory are both types of computer memory. Volatile 
Memory is used to store computer programs and data that CPU needs in real time 
and is erased once computer is switched off. RAM and Cache memory are volatile 
memory. Where as Non-volatile memory is static and remains in the computer even 
if computer is switched off. ROM and HDD are non-volatile memory. 

Following are the important differences between Volatile and Non-Volatile Memory. 

Sr. 
No. 

Key Volatile Memory Non-Volatile Memory 

1 
Data 
Retention 

Data is present till power 
supply is present. 

Data remains even after power 
supply is not present. 

2 
Persistence Volatile memory data is 

not permanent. 
Non-volatile memory data is 
permanent. 

3 
Speed Volatile memory is faster 

than non-volatile memory. 
Non-volatile memory access is 
slower. 

4 
Example RAM is an example of 

Volatile Memory. 
ROM is an example of Non-
Volatile Memory. 

5 
Data 
Transfer 

Data Transfer is easy in 
Volatile Memory. 

Data Transfer is difficult in Non-
Volatile Memory. 

6 

CPU 
Access 

CPU can access data 
stored on Volatile 
memory. 

Data to be copied from Non-
Volatile memory to Volatile 
memory so that CPU can access 
its data. 

7 
Storage Volatile memory less 

storage capacity. 
Non-Volatile memory like HDD 
has very high storage capacity. 

8 
Impact Volatile memory such as 

RAM is high impact on 
system's performance. 

Non-volatile memory has no 
impact on system's 
performance. 

9 
Cost Volatile memory is costly 

per unit size. 
Non-volatile memory is cheap 
per unit size. 



Q5: Distinguish among system software, application software and open source software on the 

basis of their features. 

Ans. Software is of two types namely system software and application 

software. They both differ in terms of their purpose and design. System 

software is meant to administer the system resources. It also serves as a 

kind of platform for running the application software. On the other hand, 

application software is meant to enable the user to carry out some specific 

set of tasks or functions. 

 

 
 

Differences between System Software and Application Software 

System software is meant to manage the system resources. It serves 

as the platform to run application software. 

Application software helps perform a specific set of 

functions for which they have been designed. 

System software is developed in a low-level language (assembly 

language for example) 

Application software is developed in a high-level language 

such as Java, C++, .net and VB. 

System software automatically starts running once the system is 

turned on and stops when the system is shut down. 

Application software runs as and when the user requests it. 

A system cannot even start without system software Application software is user specific and it is not needed to 

run the system on the whole. 

System software is endowed with a general purpose. Application software carries a specific purpose. 

A typical example for a system software is Windows Operating 

System 

Some characteristic examples for application software is 

MS Office, Photoshop and CorelDraw 

 

Q6. a) Create a file in MS-word to insert a paragraph about yourself and save it with file name 

“yourself”. Describe all steps involved in it. 

Q6 b) Write steps regarding followings 

 

nt size 

 

 



Ans. Android offers plenty of options to customize the appearance of your device, 
including your font style. If you want to change your Android font, you can use built-in 
settings to do it or use a custom launcher. 

Due to the fragmented nature of Android, changing your fonts on different Android 
manufacturers and versions will vary. The steps below are confirmed to work on a 
Samsung device running Android 9 Pie. 

Changing Built-In Font Settings 

Some Android devices and versions have built-in settings to allow you to change 
your font style. If your phone or tablet doesn‟t have these options, you won‟t be able 
to change the font style without rooting your device, which isn‟t something we 
recommend. 

If you do have the option to alter your font settings, head to the “Settings” menu on 
your Android device by swiping down the notifications shade and tapping the gear 
icon in the top right. You can also access your “Settings” menu from the app drawer. 

 

 

Once your new font style is installed, return to the “Font Style” menu and tap on it to 
switch. 



Using a Custom Launcher 

If you don‟t have the option to change your font style on your Android device, you 
can use a custom launcher instead. Two popular launchers you could choose to use 
are Nova Launcher and Action Launcher. 

Both of these launchers will display custom fonts for you, but these will only be 
displayed within the launcher itself. That means the font you see elsewhere in your 
Android settings and in other apps will remain as the Android default. 

RELATED: How To Personalize Your Android Phone With Themes and 
Launchers 

Font size and display size 

You can change your font size and display size to make your screen easier to see. 

Note: Some of these steps work only on Android 7.0 and up. Learn how to check your Android 

version. 

Change font size 

To make your font size smaller or larger: 

1. Open your device's Settings app  
2. Tap Accessibility, then tap Font size 
3. Use the slider to choose your font size 

The font size setting doesn't apply to the Google Chrome app, which has its own text scaling 
control. 

Change display size 

To make items on your screen smaller or larger: 

1. Open your device's Settings app  
2. Tap Accessibility, then tap Display size 
3. Use the slider to choose your display size 

You can change the color of text in your Word document. 

1. Select the text that you want to change. 

2. On the Home tab, in the Font group, choose the arrow next to Font Color, and then 

select a color. 

https://www.howtogeek.com/161152/what-custom-android-launchers-are-and-why-you-might-want-to-use-one/
https://play.google.com/store/apps/details?id=com.teslacoilsw.launcher
https://play.google.com/store/apps/details?id=com.actionlauncher.playstore
https://www.howtogeek.com/405455/how-to-personalize-your-android-phone-with-themes-and-launchers/
https://www.howtogeek.com/405455/how-to-personalize-your-android-phone-with-themes-and-launchers/
https://support.google.com/android/answer/7680439
https://support.google.com/android/answer/7680439


 

You can also use the formatting options on the Mini toolbar to quickly format text. 

The Mini toolbar appears automatically when you select text. 

 

Tips:  

 If you don’t see the color that you want, choose More Colors, and then select a color on 

the Standard tab, or mix your own color on the Custom tab. 

 To change the color, transparency, and shade of the text, choose Gradient. The Gradient tool is 

not available in Word 2007. 

 

 

A subscription to make the most of your time 

Try one month free 

 

 
  

 

https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie


JOIN OFFICE INSIDERS
 

  

Q7. Create a file in MS-Word for the following document and save it with file name ‘ms_word’. 

Describeall steps involved in it. 

Ans. Thanks to Microsoft Word, almost anyone can turn out professional-
looking office documents. 

Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
features. 

 
Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 
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 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 

How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 



You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Thanks to Microsoft Word, almost anyone can turn out professional-looking 
office documents. 

Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
features. 
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Sign in to your account, then click on Word. 

Start by signing in to MS Word. 

How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 



Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 

Launch Spotlight by clicking on the search icon in th 

Thanks to Microsoft Word, almost anyone can turn out professional-looking 
office documents. 

Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
features. 
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How to Launch Microsoft Word on a Mac 
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Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 

https://elements.envato.com/invoice-PN9PB2
https://elements.envato.com/invoice-PN9PB2
https://elements.envato.com/graphic-templates/print-templates/word


How to Launch Microsoft Word on a Mac 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  
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this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
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Sign in to your account, then click on Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
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Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 
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Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
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 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 
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Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 
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Thanks to Microsoft Word, almost anyone can turn out professional-looking 
office documents. 

Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
features. 



https://elements.envato.com/invoice-PN9PB2


 

Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 

Launch Spotlight by clicking on the search icon in th 
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Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
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Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 

Launch Spotlight by clicking on the search icon in th 

Thanks to Microsoft Word, almost anyone can turn out professional-looking 
office documents. 

Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
features. 
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Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 

Launch Spotlight by clicking on the search icon in th 

Thanks to Microsoft Word, almost anyone can turn out professional-looking 
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Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
features. 
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Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 

Launch Spotlight by clicking on the search icon in th 

Thanks to Microsoft Word, almost anyone can turn out professional-looking 
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Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
few minutes to become familiar and comfortable with its interface and basic 
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Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Option 2. Launch in Spotlight. 

Launch Spotlight by clicking on the search icon in th 

Thanks to Microsoft Word, almost anyone can turn out professional-looking 
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Even if you‟ve never used MS Word before, you‟ll find that it only takes a 
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Learn some basic Microsoft Word principles such as how to create and save a Word document using 

this template from Envato Elements. 

Note: We used the Invoice template from Elements to create this letter. 
Find more great Word templates from Envato Elements. 

In this tutorial, I'll show you how to write a business letter in MS Word. In 
the process, you'll learn the answers to the following: 

 How to create a Word document? 
 How do you save a file on Microsoft Word? 
 How to open a new file in MS Word? 
 How do you use a Word template? 
 How do you copy a Word document? 

By the end of the tutorial, you'll be able to create your own document using 
Microsoft Word. 

Launch Microsoft Word 

Start by launching Microsoft Word. To use Microsoft Word online, you must 
have an Office 365 account (paid).  

Sign in to your account, then click on Word. 

Start by signing in to MS Word. 
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How to Launch Microsoft Word on a Mac 

If you‟re on a Mac, you've got several options for launching Microsoft Word. 

Option 1. Launch in Finder  

Go to Applications, then double-click on Microsoft Word. 

You can launch Microsoft Word through the Finder on a Mac. 

Note: In this tutorial, I’m using a Mac so that's the interface you see. If 
you’re on Windows, the steps will be similar, albeit with different names for 
different applications and interfaces. For example, Finder on a Mac is either 
Windows Explorer or File Explorer on Windows, depending on which 
version you're using. 

Q8. Create a file in MS-word for the following document and save it 
with file name ‘equations’. Describeall steps involved in it. 

Ans. Chapter 1.  Creating, Opening, 

and Saving Documents 

Word. Microsoft Word has been the world’s most popular word 

processor for so long, it needs only one name—like Oprah or 

Madonna. Unlike certain celebrities, though, Word has undergone a 



makeover that goes well beyond cosmetic. Microsoft has 

redesigned the way you interact with the program and has 

redefined the underlying document format (don’t worry; your old 

Word documents will still work). 

Some things haven’t changed: Just like previous versions, Word 

2007 still makes it easy to create professional-looking letters, 

business reports, and novels. But Microsoft has loaded the program 

with new features to make designing and formatting attractive 

documents easier than ever. So even if you’re well acquainted with 

its predecessors, you might need a little help getting used to the 

new Word. For example, some of the commands that are old 

favorites—like Cut and Paste—are in new places. This chapter 

gives you an overview of the major changes, and the chapters that 

follow give you all the details. 

Just as in previous version of Word, every project you create in 

Word 2007 begins and ends the same way: You start by creating a 

document, and you end by saving your work. Sounds simple, but to 

manage your Word documents effectively, you need to know these 

basics and beyond. This chapter shows you all the different ways to 

create a document in Word 2007—like starting from an existing 

document or adding text to a predesigned template—and how to 

choose the best one for your particular project. 

You’ll also learn how to work faster and smarter by changing your 

view of your document. If you want, you can use Word’s Outline 

view when you’re brainstorming, and then switch to Print view when 

you’re ready for hard copy. This chapter gets you up and running 

with these fundamental tools so you can focus on the important 

stuff—your words. 

TIP 

If you’ve used Word before, then you’re probably familiar with opening and 

saving documents. Still, you may want to skim this chapter to catch up on the differences 



between this version of Word and the ghosts of Word past. You’ll grasp some of the big 

changes just by examining the figures. For more detail, check out the gray boxes and 

the notes and tips—like this one! 

What Word Does 

You type words, and they appear onscreen, what else? Well, 

maybe in the first version of Word. But in Word 2007, the program 

does a whole lot more. Word’s designers knew what kinds of 

documents folks are likely to create, and stocked the program with 

predesigned templates that have all the important elements in 

place-headings, signature line, text boxes, and so on. You don’t 

even have to worry about making it look nice: Word comes with 

attractive, built-in color schemes—called themes—that you can 

apply with a single click. Here are just some of the things you can 

create: 

 Letters, lists, notecards, and other personal documents. You 

can even print your own greeting cards and invitations. 

 Programs, menus, and booklets. Some of Word’s templates 

are multipage affairs, letting you create scrapbooks, catalogs, 

playbills, and more. 

 Brochures, reports, business cards, and other business 

documents. Word even has a feature that lets you create tables, so 

you don’t have to use a spreadsheet program like Excel for simple 

tables. Word’s are better looking, too. 

To create all these documents, all you have to do is type the words. 

But even there, Word takes some of the work off your hands. It has 

tools that help you check your spelling and grammar, and look up 

facts and definitions. Word’s AutoText feature even does some of 

the typing for you. And if you need an illustration, Word gives you a 

slew of pictures you can plunk right onto the page—no drawing 

skills required. 

NOTE 



The word portion of this book is based on Word 2007: The Missing Manual (O’Reilly). 

That book is a truly complete reference for Word 2007, covering every feature, including 

geeky stuff like creating indexes and tables of contents in Word, collaborating with other 

writers in the same document, and running off form letters by merging Word with a list of 

names and addresses. If you get really deep into Word and want to learn more, Word 

2007: The Missing Manual can be your trusted guide. 

The New Word 

In the past, when Microsoft introduced new versions of Word, it seemed as 

if the developers had simply tacked new features on top of the old program 

wherever they’d fit. Sometimes the result was sort of like putting fins on a 

Volkswagen beetle. 

With Word 2007, however, Microsoft listened to the critics who 

complained about Word’s maze of menus and dialog boxes. There were 

also legitimate complaints about illogically placed commands and 

important tools that were buried. With Word 2007, all the commands have 

been reorganized and placed on the ribbon (The Ribbon) according to task 

and function. Is the new system going to put a smile on everyone’s face? 

No, probably not. Is it an improvement that makes Word easier to use for 

most people? Yes. 

Another concern was security. Microsoft has made major changes in 

Word’s file formats to minimize the chance that you’ll open a document 

containing a virus. It would be naïve to think these steps will eliminate 

virus threats, but they’ll certainly help. 

In addition to the new features common to all the Office 2007 

applications—see the introduction for a rundown—Word got some 

upgrades all its own: 

 Building Blocks for better docs. Word 2007’s Building 

Blocks save time and stress if you consider yourself a writer (or a 

doctor, or a manager), not a designer. Building Blocks are 

predesigned, preformatted elements that you can easily drop into 

your document. Microsoft has thrown in dozens of things like 

https://www.oreilly.com/library/view/office-2007-the/9780596514228/pr03.html#the_ribbon


headers, footers, tables of contents, and fax cover pages. Choose a 

Building Block with the look you want, and then pop it into your 

document, knowing it will look good and include any of the pertinent 

details, like page number, document title, even your name. 

 Help! Get me security. That was the cry of many Word users 

when they opened a document only to let loose a virus on their 

poor, unsuspecting computer. Microsoft has tackled security 

problems from several different directions. For example, Word 2007 

has a new file format that makes it easier to ferret out documents 

that may contain virus-infected programs. (When it comes to Word 

viruses, the main culprits are Visual Basic for Applications and the 

tools it creates, called ActiveX controls.) In Word 2007, it’s also 

easier than ever to add digital signatures to documents to make 

sure files come from a trusted source and haven’t been tampered 

with. 

 File this way, please. The groans are audible any time an 

industry standard like Microsoft Word makes major changes to its 

file format. The file format is the way a program writes information 

to a computer disc. As mentioned earlier, Microsoft is switching to a 

new file format for the best of reasons—to make all our computers 

safer from viruses. The downside of a new file format is that you 

can’t open the new documents with older versions of Word unless 

you install a compatibility pack for the older programs. 

Launching Word 

The first time you launch Word after installation, the program asks 

you to confirm your name and initials. This isn’t Microsoft’s 

nefarious plan to pin you down: Word uses this information to 

identify documents that you create and modify. Word uses your 

initials to mark your edits when you review and add comments to 

Word documents that other people send to you. 

You have three popular ways to fire up Word, so use whichever 

method you find quickest: 



 Start menu. The Start button in the lower-left corner of your 

screen gives you access to all programs on your PC—Word 

included. To start Word, choose Start → All Programs → Microsoft 

Office → Microsoft Office Word. 

 Quick Launch toolbar. The Quick Launch toolbar at the 

bottom of your screen (just to the right of the Start menu) is a great 

place to start programs you use frequently. Microsoft modestly 

assumes that you’ll be using Word a lot, so it usually installs the 

Word icon in the Quick Launch toolbar. To start using Word, just 

click the W icon, and voila! 

 
Q9. Create a file in MS-word that convert existing highlight text to table as shown below and save it 

asfile name ‘text_to_table’. Describe all steps involved in it. 

Ans. Convert text to a table or a 

table to text 

Word for Microsoft 365 Outlook for Microsoft 365 Word 2019 Outlook 2019 More... 

To convert text to a table or a table to text, start by clicking 

the Show/Hide paragraph mark on the Home tab so you can see how text is 

separated in your document. 

 

javascript:


Convert text to a table 

1. Insert separator characters—such as commas or tabs—to indicate where to divide 

the text into table columns. 

Note: If you have commas in your text, use tabs for your separator characters. 

2. Use paragraph marks to indicate where you want to begin a new table row. 

In this example, the tabs and paragraph marks will produce a table with 3 columns 

and 2 rows: 

 

3. Select the text that you want to convert, and then click Insert > Table > Convert 

Text to Table. 

 



4. In the Convert Text to Table box, choose the options you want. 

 

Under Table size, make sure the numbers match the numbers of columns and rows 

you want. 

Under AutoFit behavior, choose how you want your table to look. Word 

automatically chooses a width for the table columns. If you want a different column 

width, choose one of these options: 

To do this Choose this option 

Specify a width for all the columns In the Fixed column 

width box, type or select a 

value. 

Resize the columns to fit the width of the text in each column AutoFit to contents 

Resize the table automatically in case the width of the available 

space changes (for example, web layout or landscape orientation) 

AutoFit to window 

Under Separate text at, choose the separator character you used in the text. 

5. Click OK. The text converted to a table should look something like this: 

 



Convert a table to text 

1. Select the rows or table you want to convert to text. 

2. On the Layout tab, in the Data section, click Convert to Text. 

 

3. In the Convert to Text box, under Separate text with, click the separator character 

you want to use in place of the column boundaries. Rows will be separated by 

paragraph marks. 

4. Click OK. 

Q11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

Ans. Every Excel grandmaster needs to start somewhere. In this 

chapter, you’ll learn how to create a basic spreadsheet. First, you’ll 

find out how to move around Excel’s grid of cells, typing in numbers 

and text as you go. Next, you’ll take a quick tour of the Excel ribbon, 

the tabbed toolbar of commands that sits above your spreadsheet. 

You’ll learn how to trigger the ribbon with a keyboard shortcut, and 

collapse it out of the way when you don’t need it. Finally, you’ll go to 

Excel’s backstage view, the file-management hub where you can 

save your work for posterity, open recent files, and tweak Excel 

options. 

Starting a Workbook 

When you first fire up Excel, you’ll see a welcome page where you 

can choose to open an existing Excel spreadsheet or create a new 

one (Figure 1-1). 

https://www.oreilly.com/library/view/excel-2013-the/9781449359492/ch01.html#excels_welcome_page_lets_you_create_a_ne


 

Figure 1-1. Excel’s welcome page lets you create a new, blank worksheet or a ready-made 

workbook from a template. For now, click the “Blank workbook” picture to create a new 

spreadsheet with no formatting or data. 

Excel fills most of the welcome page with templates, spreadsheet 

files preconfigured for a specific type of data. For example, if you 

want to create an expense report, you might choose Excel’s “Travel 

expense report” template as a starting point. You’ll learn lots more 

about templates in Chapter 16, but for now, just click “Blank 

workbook” to start with a brand-spanking-new spreadsheet with no 

information in it. 

NOTE 

Workbook is Excel lingo for “spreadsheet.” Excel uses this term to emphasize the fact 

that a single workbook can contain multiple worksheets, each with its own grid of data. 

https://www.oreilly.com/library/view/excel-2013-the/9781449359492/ch16.html


You’ll learn about this feature in Chapter 4, but for now, each workbook you create will 

have just a single worksheet of information. 

You don’t get to name your workbook when you first create it. That 

happens later, when you save your workbook (Saving Files). For 

now, you start with a blank canvas that’s ready to receive your 

numerical insights. 

Adding Information to a Worksheet 

When you click “Blank workbook,” Excel closes the welcome page 

and opens a new, blank worksheet, as shown in Figure 1-2. A 

worksheet is a grid of cells where you type in information and 

formulas. This grid takes up most of the Excel window. It’s where 

you’ll perform all your work, such as entering data, writing formulas, 

and reviewing the results. 

 

Figure 1-2. The largest part of the Excel window is the worksheet grid, where you type in 

your information. 

Here are a few basics about Excel’s grid: 

https://www.oreilly.com/library/view/excel-2013-the/9781449359492/ch04.html
https://www.oreilly.com/library/view/excel-2013-the/9781449359492/ch01.html#saving_files
https://www.oreilly.com/library/view/excel-2013-the/9781449359492/ch01.html#the_largest_part_of_the_excel_window_is_


 The grid divides your worksheet into rows and columns. 

Excel names columns using letters (A, B, C…), and labels rows 

using numbers (1, 2, 3…). 

 The smallest unit in your worksheet is the cell. Excel 

uniquely identifies each cell by column letter and row number. For 

example, C6 is the address of a cell in column C (the third column) 

and row 6 (the sixth row). Figure 1-3 shows this cell, which looks 

like a rectangular box. Incidentally, an Excel cell can hold 

approximately 32,000 characters. 

 A worksheet can span an eye-popping 16,000 columns 

and 1 million rows. In the unlikely case that you want to go beyond 

those limits—say, if you’re tracking blades of grass on the White 

House lawn—you’ll need to create a new worksheet. Every 

spreadsheet file can hold a virtually unlimited number of 

worksheets, as you’ll learn in Chapter 4. 

 When you enter information, enter it one cell at a time. 

However, you don’t have to follow any set order. For example, you 

can start by typing information into cell A40 without worrying about 

filling any data in the cells that appear in the earlier rows. 

Q12. Calculate the following things of a range (C2:C11) of data in the worksheet 

created in question no 

. the sum of the marks using AutoSum in a range of cells (C2:C11) 

Q12. Calculate the following things of a range (C2:C11) of 

data in the worksheet created in question no 

10. 

 

 

 

 

https://www.oreilly.com/library/view/excel-2013-the/9781449359492/ch01.html#in_this_spreadsheet_the_active_cell_is_c
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Q13 a) Describe various steps involved in the following

ange of cells (C2:C11) 

 

11) 

 

 

A subscription to make the most of your time 

Try one month free 

 

   

Need more help? 

Expand your Office skills 

EXPLORE TRAINING
 

  

Get new features first 

JOIN OFFICE INSIDERS
 

  

Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it. 

Ans. The basic steps for creating a standard table in Microsoft Word (2013) are: 

1. Open a blank Word document 

https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.facebook.com/sharer.php?u=https://support.microsoft.com/en-us/office/convert-text-to-a-table-or-a-table-to-text-b5ce45db-52d5-4fe3-8e9c-e04b62f189e1
https://www.facebook.com/sharer.php?u=https://support.microsoft.com/en-us/office/convert-text-to-a-table-or-a-table-to-text-b5ce45db-52d5-4fe3-8e9c-e04b62f189e1
https://support.microsoft.com/en-us/training
https://insider.office.com/
https://www.microsoft.com/microsoft-365/try?ocid=oo_support_mix_marvel_ups_support_tryfloatie
https://www.facebook.com/sharer.php?u=https://support.microsoft.com/en-us/office/convert-text-to-a-table-or-a-table-to-text-b5ce45db-52d5-4fe3-8e9c-e04b62f189e1
https://linkedin.com/shareArticle?mini=true&url=https://support.microsoft.com/en-us/office/convert-text-to-a-table-or-a-table-to-text-b5ce45db-52d5-4fe3-8e9c-e04b62f189e1&title=Convert+text+to+a+table+or+a+table+to+text
mailto:?subject=I think you'd be interested in this: Convert text to a table or a table to text&body=Convert text to a table or a table to text
https://support.microsoft.com/en-us/office/convert-text-to-a-table-or-a-table-to-text-b5ce45db-52d5-4fe3-8e9c-e04b62f189e1


2. In the top ribbon, press Insert 

 

3. Click on the Table button 

 

4. Either use the diagram to select the number of columns and rows you need, or click Insert 
Table and a dialog box will appear where you can specify the number of columns and rows. 

 

5. The blank table will now appear on the page. Alter it as necessary. Standard features 
like bold, italics, and underline are still available! These items may be helpful for creating 
headings or calling out certain items in the table. 

6. Follow these instructions for ensuring your table meets APA formatting guidelines. 

 

Need additional help? The tutoring service has self-paced table and chart lessons/tutorials within 
SkillSurfer. Follow these steps to access: 

http://rasmussen.libanswers.com/faq/40903


1. Log into the tutoring service (click on the blue hyperlink to the left to login!) 

2. Click on SkillSurfer 

3. Click on Computers and Technology 

4. Click on Intermediate underneath Microsoft Word 

5. Select Creating Tables and Charts 

6. Choose the exact item(s) you wish to learn about (likely Creating Tables from Scratch). 

 

  

Q12. Calculate the following things of a range (C2:C11) of data in the worksheet created in question 

no 

10. 

 

 

11) 

 

Ans. Use the SUM function to sum numbers in a range 
Excel for Microsoft 365 Excel for the web Excel 2019 Excel 

2016 Excel 2013 

You can use a simple formula to sum numbers in a 

range (a group of cells), but the SUM function is 

easier to use when you’re working with more than a 

https://portal.rasmussen.edu/Pages/Brainfuse.aspx
https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89


few numbers. For example =SUM(A2:A6) is less likely 

to have typing errors than =A2+A3+A4+A5+A6. 

 

Here’s a formula that uses two cell 

ranges: =SUM(A2:A4,C2:C3) sums the numbers in 

ranges A2:A4 and C2:C3. You’d press Enter to get the 

total of 39787. 

To create the formula: 

1. Type =SUM in a cell, followed by an opening 

parenthesis (. 

2. To enter the first formula range, which is called 

an argument (a piece of data the formula needs to 

run), type A2:A4 (or select cell A2 and drag through 

cell A6). 

3. Type a comma (,) to separate the first argument from 

the next. 

4. Type the second argument, C2:C3 (or drag to select 

the cells). 

5. Type a closing parenthesis ), and then press Enter. 

Each argument can be a range, a number, or single 

cell references. 



much you were spending. You could put together a spreadsheet like the one below, with the list 
of items to be purchased, their unit prices, the number of each item ordered, and the total spent 
for each.  It would make sense to enter the things you know in advance (like the price of 
individual items and the number ordered), but you could let Excel calculate the totals for 
you.  For the first item listed below (pencils), this could be done by making the value of the total 
price (cell D2), the value of the unit price (held in cell C2) multiplied by the number of items 
ordered (held in D2).  This formula would be written "=B2*C2". 

 Let's say you were putting together an office supply order, and you wanted to keep track 
of 

After hitting "Enter", the cell will display the calculated value, while the formula bar will still 
display the formula.  (Note: Always hit “Enter” when finished entering a formula, manually.  If 
you click off the cell, the cell you click to will be added to your formula.) 

 

Excel will generally be able to handle any properly-input mathematical formula, if valid operators 
are used. Commonly used operators include "+" (addition), "-" (subtraction), "*" (multiplication) 
and "/" (division).  (Microsoft has a complete list of valid operators to be used in Excel 
formulas on the Office website).  Here are some examples of formulas using common operators: 

 Excel MAXIFS function 

The MAXIFS function returns the largest numeric value in 
the specified range based on one or more criteria. 

The syntax of the MAXIFS function is as follows: 

MAXIFS(max_range, criteria_range1, 

criteria1, [criteria_range2, criteria2], …) 

Where: 

https://support.office.com/en-us/article/Calculation-operators-and-precedence-in-Excel-48be406d-4975-4d31-b2b8-7af9e0e2878a
https://support.office.com/en-us/article/Calculation-operators-and-precedence-in-Excel-48be406d-4975-4d31-b2b8-7af9e0e2878a


 Max_range (required) - the range of cells where you want 
to find the maximum value. 

 Criteria_range1 (required) - the first range to evaluate 
with criteria1. 

 Criteria1 - the condition to use on the first range. It can be 
represented by a number, text or expression. 

 Criteria_range2 / criteria2, …(optional) - additional ranges 
and their related criteria. Up to 126 range/criteria pairs are 
supported. 

This MAXIFS function is available in Excel 2019 and Excel 
for Microsoft 365 on Windows and Mac. 

As an example, let's find the tallest football player in our 
local school. Assuming the students' heights are in cells 
C2:C11 (max_range) and sports are in B2:B11 
(criteria_range1), use the word "football" as criteria1, and 
you will get this formula: 

=MAXIFS(C2:C11, B2:B11, "football") 

To make the formula more versatile, you can input the 
target sport in some cell (say, G1) and include the cell 
reference in the criteria1 argument: 

=MAXIFS(C2:C11, B2:B11, G1) 

 



 Max_range (required) - the range of cells where you want 
to find the maximum value. 

 Criteria_range1 (required) - the first range to evaluate 
with criteria1. 

 Criteria1 - the condition to use on the first range. It can be 
represented by a number, text or expression. 

 Criteria_range2 / criteria2, …(optional) - additional ranges 
and their related criteria. Up to 126 range/criteria pairs are 
supported. 

This MAXIFS function is available in Excel 2019 and Excel 
for Microsoft 365 on Windows and Mac. 

As an example, let's find the tallest football player in our 
local school. Assuming the students' heights are in cells 
C2:C11 (max_range) and sports are in B2:B11 
(criteria_range1), use the word "football" as criteria1, and 
you will get this formula: 

=MAXIFS(C2:C11, B2:B11, "football") 

To make the formula more versatile, you can input the 
target sport in some cell (say, G1) and include the cell 
reference in the criteria1 argument: 

=MAXIFS(C2:C11, B2:B11, G1) 

Q13 b) Describe following terms in the worksheet 

 

 

ll address 

Ans. To create and copy a formula using relative 

references: 



In the following example, we want to create a formula that will 

multiply each item's price by the quantity. Rather than create a 

new formula for each row, we can create a single formula in 

cell D2 and then copy it to the other rows. We'll use relative 

references so the formula correctly calculates the total for each 

item. 

1. Select the cell that will contain the formula. In our example, 

we'll select cell D2. 

 

2. Enter the formula to calculate the desired value. In our example, 

we'll type =B2*C2. 



 

3. Press Enter on your keyboard. The formula will be calculated, 

and the result will be displayed in the cell. 

4. Locate the fill handle in the lower-right corner of the desired 

cell. In our example, we'll locate the fill handle for cell D2. 



 

Q14. a) What tools are available to customize our 

PowerPoint presentation? 

Ans. Tools Used By Pro 
PowerPoint Presentation 
Designers 
Published on 

May 19, 2016 

PowerPoint presentation designers are termed „pro‟ for one reason and that‟s 

because they can transform an ordinary presentation into an enticing piece of 

information. Designers make a presentation stand out with attractive designs and 

eye-catching graphics. Ever wondered what tools that Powerpoint designers use to 

create magic in a presentation? Well, read on as we discuss them. 

Some of the tools that professional presentation designers use can be found in 

Microsoft PowerPoint itself; however, there are some third-party tools which are also 

https://www.stinsondesign.com/services
https://www.stinsondesign.com/services


used to enhance the overall look and feel of the slides. PowerPoint presentation 

designers create slides with one and only aim in mind is to stun the audience with 

impressive graphics while ensuring that a message is communicated effectively. 

Q14 b) Write the steps for the following action for creation of power 

point presentation 

 

 

 

and last name in the Subtitle section 

 

Ans. Creating a Blank Presentation 

When you start PowerPoint, click on New. Click on the option to create a Blank Presentation. A 
blank presentation has a white background and black text without any additional design 
elements. 

By default, the presentation only contains a title slide. You can click on the text boxes and type in 
your own text. To add a slide, click on the option for a New Slide and select the type of slide you 
want. Any new slides will also have a white background and simple text boxes. 

Customizing a Presentation 

Once you have added some content to your blank presentation, you can manually make changes 
to the various design elements. For example, you can modify the background. Select 
the Design ribbon at the top and click on the Format Background option. This allows you to select 
various types of backgrounds, including a solid fill, gradient fill, and several other options. 

Once you have found an option you like, you can click on Apply to All to apply the current 
background style to all the slides in the presentation. You can select any of the elements on your 



slide and change their design. For example, to change the color of the text in a textbox, select 
the textbox, select the Home ribbon at the top, and apply a different color. 

 Create a Blank Presentation 

 Save a Presentation 

 Apply a Design Theme 

 Compare Presentation Views 

 Format Text 

 Insert SmartArt 

 Insert & Modify Shapes 

 Edit & Duplicate Slides 

Instructions 

1. Open a Blank presentation 
2. Save the presentation as PowerPointLabOne.pptx 
3. Add a Title to the first slide: the name of your college 
4. Type your first name and last name in the Subtitle section 
5. Add a New Slide which has a Title and Content 
6. Add a title to the second slide “My Future Goals” 

7. In the Content section of the second slide, add at least three Personal Goals 

8. Right click on the second slide from the left panel, then choose Duplicate Slide 
9. Highlight the text in the Content area of the third slide. Under the Home tab, 

click Convert to SmartArt, then choose Basic Cycle 
10. Change the SmartArt Colors to Colorful—Accent Colors 
11. Change the SmartArt Styles to 3D Polished 
12. From the left panel, drag the third slide between the first and second slide 
13. Change the layout of the third slide, the slide that does not have the SmartArt, 

to Comparison 
14. Leave the title “My Future Goals” 
15. In the head of the first column, type “Goals in College,” then center the heading 
16. In the head of the second column, type “Goals after College,” then center the 

heading 
17. Add at least three goals in each section 
18. Make sure that slide #3 is selected from the left panel, then add a New Slide 
19. Change the layout of the new slide to Blank 
20. Insert a Graduation Online Picture from the Office ClipArt—Choose any image of 

your choice 
21. Change the ClipArt size to 3” X 3” and position it in the middle of the slide 
22. Apply the Wisp Design Theme 
23. Save and upload PowerPointLabOne.pptx to your instructor 

 
Q15. Write steps for creation of a set of PowerPoint slides that demonstrates your skill to 
use 
the tools of PowerPoint. It should include the following things 

 
 

 
 



Ans. slide master bullets not working 

 HOME 
 CONTACT 

Want more? I can certainly understand the desire for more formatting options within the slide 
masters, and it's something our team has on their radar as an enhancement to the current 
Storyline set up. You can pick bullets or a numbering scheme when the insertion point is in any 
text, whether in the title placeholder, text placeholder, or even on the drawing layer. The 
doohickey is probably a part of the Slide Master. I have just been asked to format bullets myself 
in the master slide.Thank you. Slide masters will not keep bullet formatting, and that'll have to be 
set up on the individual slides themselves. Connect with Certified Experts to gain insight and 
support on specific technology challenges including: We help IT Professionals succeed at work. 
New slides won't contain default bullets, and you'll be less tempted to use them. Reply; Actions. 
Then click the Slide Master thumbnail for editing 

Insert a worksheet 

 Select the    plus icon at the bottom of the screen. 

 Or, select Home > Insert > Insert Sheet. 

 

Insert a worksheet 

 Select the    plus icon at the bottom of the screen. 

 Or, select Home > Insert > Insert Sheet. 

http://learningresources.macmillaneducation.in/maced/the-poetry-cazgmv/91a193-slide-master-bullets-not-working
http://learningresources.macmillaneducation.in/maced/the-poetry-cazgmv/91a193-slide-master-bullets-not-working


 

Rename a worksheet 

 Double-click the sheet name on the Sheet tab to 

quickly rename it. 

 Or, right-click on the Sheet tab, click Rename, and 

type a new name. 

Delete a worksheet 

 Right-click the Sheet tab and select  Delete. 

 Or, select the sheet, and then 

select Home > Delete > Delete Sheet. 

Text Clip Art - Royalty Free 

 Next » 

1 - 75 of 1,838,569 images 

Text Stock Photos Text Stock Illustrations 

Orientations:  

Clear 

  

Horizontal 

  

Panoramic Horizontal 

  

Panoramic Vertical 

https://www.gograph.com/stock-photo-images/text.html
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Square 

  

Vertical 

Toggle Captions  

Related Searches: Texting, Words, Letters, Text 

Message, Fonts, Writing, Vintage, Typography, Pencil, Cupcake, Text 

Box, Message, People, Mining, Book, Phone, Music, Design 
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Slideshow Templates for After Effects 
11 Free After Effects Templates for Slideshow. Show off your portfolio or collect your 
special memories with these stunning slideshow templates for After Effects. From 
weddings and birthdays to simple and cinematic style templates, you can create your 
very own slideshow and always hold a ticket to go down memory lane. All of 
our After Effects Templates are free to download and ready to use in your next video 
project, under the Mixkit License. 
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